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CHAPTER 1

Introduction
Flare Desktop lets you work with numbered, bulleted, and definition lists in a variety of ways. This
includes creating simple and multi-level lists, creating custom list formats, editing list styles,
merging lists, sorting lists, restarting numbering, and more.

General Information

n "Quick List Drop-Down Menu" on page 8

n "Snippets in Lists" on page 9

n "Advanced Lists With Autonumbers" on page 10

n "List Features Per Output Type" on page 11

Main Activities

n "Creating Numbered and Bulleted Lists" on page 13

n "Creating Definition Lists" on page 15

n "Working With Paragraph and Simple List Items" on page 25

n "Setting Page and Column Breaks for Lists" on page 33

n "Editing List Styles" on page 39

Other Activities

n "Creating Custom List Formats" on page 68

n "Editing Custom List Formats" on page 83
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n "Continuing the Sequence of Lists" on page 93

n "Merging Lists" on page 96

n "Restarting Numbering in Lists" on page 98

n "Reversing Lists" on page 99

n "Sorting Lists" on page 100

n "Unbinding Lists" on page 101
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CHAPTER 2

General Information for Lists
There are various pieces of general information you should know if you plan to use this feature.

This chapter discusses the following:

Quick List Drop-Down Menu 8

Snippets in Lists 9

Advanced Lists With Autonumbers 10

List Features Per Output Type 11
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Quick List Drop-Down Menu
The easiest way to create a numbered, bulleted, or definition list is to use Flare Desktop's quick
drop-down menu button in the Home ribbon. Click the down arrow next to the list button and
select a format from the menu. However, when creating numbered or bulleted lists, it is a best
practice to limit your selections to the Bullet List and Numbered List options, then rely on
list style settings to provide the type of list item automatically depending on its level.

Option Description

Inserts a bullet list (recommended).

Inserts a circle bullet list.

Inserts a square bullet list.

Inserts a numbered list (recommended).

Inserts a lower alpha numbered list.

Inserts an upper alpha numbered list.

Inserts a lower Roman numbered list.

Inserts an upper Roman numbered list.

Inserts a definition list.
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Snippets in Lists
Keep in mind that snippets inserted as list items are treated differently, depending on whether they
are inserted as block snippets versus text snippets. A block snippet consumes all of the space
where it was inserted, whereas a text snippet does not (i.e., you can add more text in front of it or
after it).

n Block Snippets A block snippet in a list item retains the styling used on the content in that
snippet (e.g., if the paragraph color in the snippet is blue, it will continue to be blue).

n Text Snippets A text snippet in a list item uses the styling for the list (e.g., if the paragraph
color in the snippet is blue but in the list it is red, the content in the inserted snippet will be
red). To use a text snippet, first type a single character in the empty list item, drag the snippet
next to it, then remove the character.
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Advanced Lists With Autonumbers
In addition to using the quick list drop-down menu, you can use autonumbering to create more
advanced types of lists. You might want to use autonumbering on lists, for example, if you want the
list items to contain text in addition to numbers (e.g., Step 1, Step 2, Step 3). A list using
autonumbers also supports cross-references to specific list items.
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List Features Per Output Type
Following are list features supported in each output type.

HTML5 PDF Word
Clean
XHTML

Eclipse
Help EPUB

HTML
Help PPTX

Breaks
(Page and
Column)

Custom
List
Formats

Definition
Lists

Numbered
and
Bulleted
Lists

Styles
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CHAPTER 3

Main Activities for Lists
Some activities are particularly common and important when it comes to this feature.

This chapter discusses the following:

Creating Numbered and Bulleted Lists 13

Creating Definition Lists 15

Working With Paragraph and Simple List Items 25

Setting Page and Column Breaks for Lists 33

Editing List Styles 39
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Creating Numbered and Bulleted Lists
You can create single-level or multi-level numbered or bulleted lists using Flare Desktop's quick
drop-down menu on the Home ribbon, as well as by using styles. From the quick drop-down
menu, you can select various list formats (e.g., circle bullet, alpha number, Roman number).
However, it is a best practice to limit your selections to the Bullet List and Numbered List options,
then rely on list style settings to provide the type of list item automatically depending on its level.
For example, for a three-level numbered list, you can place settings on the ol style for the first level,
on ol ol for the second level, and on ol ol ol for the third level.

How to Create a Numbered or Bulleted List
1. Open the content file and place your cursor where you want to insert a list.

2. Select Home > (down arrow) and choose a list type from the menu (recommend Bullet
List or Numbered List).

3. Enter text for the list item. Then press ENTER to move to the next list item and repeat.

NOTE By default, Flare Desktop adds <p> tags inside <li> tags in a list. This makes it
easier to add paragraph items (e.g., notes, images) between list items. On an empty
list item line, you can press BACKSPACE to remove the bullet or number and then add
your content. For more details, see "Working With Paragraph and Simple List Items"
on page 25.

On the XML Editor tab of the Options dialog, you can change the default behavior, so
that list items do not have paragraph items initially.

NOTE See the Help system for or the Shortcuts Cheat Sheet PDF for shortcuts you
can use in lists.
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4. (Optional) If you want to move to a second level of the list, press Tab or in the Home ribbon
click the indent button .

If you are on one type of list and want to switch to the other kind of list (e.g., you are on a
numbered list and want to change to bullets), right-click on the ol (numbered list) or ul
(bulleted list) structure bar to the left, and from the context menu select Type. Then click one
of the list types (Bullet List or Numbered List).

If you want to move back to a higher level list (e.g., you are on the third level and want to
move back to the second level), click the outdent button in the Home ribbon.

NOTE If you have created and edited list style classes, you can right-click on the ol or
ul structure bar to the left, and from the context menu select Style > [Name of Style
Class].

5. If you are at the end of the entire list and want to exit the list altogether, press ENTER again
on a blank list item. You should now be outside of the list and on a regular paragraph.

6. Click to save your work.
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Creating Definition Lists
A definition list is used to create a group of terms and definitions. It is also sometimes referred to
as a description list, and although it is called a "list," it does not have bullets or numbers. Instead, it
is similar to a table that doesn't have borders (although it can have borders, shading, etc. if you edit
the necessary styles).
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Definition List Tags and Styles
A definition list contains the following tags, which use corresponding styles to control their look.

n dl This refers to a definition list, which is the container holding the individual terms and
definitions.

n dt This refers to a term in a definition list.

n dd This refers to a definition in a definition list.
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EXAMPLE You might create a definition list that initially looks like this:
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Then you add these definition list styles to your stylesheet:

dl
{
    width: 520px;
    padding: 0;
    border-bottom: solid 1px #000000;
}

dl dt,
dt
{
    clear: left;
    float: left;
    width: 100px;
    margin: 0;
    padding: 5px;
    border-top: solid 1px #000000;
    font-weight: bold;
}

dl dd,
dd
{
    margin: 0;
    padding: 5px;
    border-top: solid 1px #b9bec1;
    margin-left: 100px;
}

dt + dd
{
    border-top: solid 1px #000000;
}

CHAPTER 3  18



As a result, the definition list (and others that you create in the project) will look like this
instead:
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Definition Lists and Context
By using definition list tags—as opposed to different markup, such as headings and regular
paragraphs—you are providing context for the content. In other words, not only do end users
recognize they are looking at a list of definitions and terms, but this kind of semantic markup allows
meta data to be associated with it. Therefore, that information can more easily be extracted
automatically.
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Snippets and Definition Lists
One of the benefits of creating a definition list instead of using a table has to do with snippets.
While creating snippets for parts of a table can be quite difficult, if not impossible, producing
snippets from parts of a definition list is easy.

EXAMPLE You have a table with three rows.

You want to create a snippet of the middle row so that you can insert it into other tables.
When you right-click the tr structure bar, notice that there isn't even an option to create a
snippet.
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However, if you have the same content in a definition list…

… you can select the relevant content…

… and select Home > Create Snippet.

A snippet is created, which you can then insert in the midst of any other definition lists.
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How to Create a Definition List
1. Place your cursor in the XML Editor where you want to begin the list.

2. From the Home ribbon, click the down arrow in the list button , and select Definition List.

The structure bars to the left indicate that you have a <dl> (list) tag and a <dt> (term) tag
within it.
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3. Type the term and press ENTER.

Now you see another structure bar representing a <dd> (definition) tag.

4. Type the definition and press ENTER.

Another <dd> tag is created, in case you want to add another definition line for the term.

5. Do one of the following:

n Add Another Definition Type the definition, then press ENTER.

n Add Another Term Press ENTER (which changes the line from a <dd> tag to a <dt> tag),
then type the term.

n Exit Definition List Press ENTER twice (which places the cursor on a new <p> tag).

6. Click to save your work.
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Working With Paragraph and Simple
List Items

When creating a list, you may want to include information (e.g., additional text, notes, images)
between items without interrupting the flow of the list. You can do this with paragraph items (i.e.,
<p> tags within list tags). These are automatically added to new bulleted and numbered lists.
However, you can remove them if you want. You can also change your default settings so that new
lists do not initially include paragraph items. Definition lists do not initially have paragraph items by
default, but you can change that if you want.

How to Add Content Between List Items
1. Make sure the list item where you want to add the content has a <p> tag in it.

2. At the end of the list item text, press ENTER.

3. Press BACKSPACE. The number or bullet is removed.

NOTE If you change your mind and want to add the number or bullet back, you can
click the paragraph item icon or press SHIFT+TAB.

4. Type or insert the content.

5. Click to save your work.
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How to Add Paragraph Tags in a Simple List
A simple list means a list where there are <li> tags without <p> tags within them. So a simple list
item is a single <li> tag without a <p> tag within it.

1. Click in the list where you want to add a paragraph item.

2. If the tag block bars are not shown to the left of the content, click at the bottom of the
editor.

3. Right-click the list tag bar (e.g., ol, ul, li, dd) that represents the item where you want to add a
paragraph item(s). Then select Make Paragraph Item(s). A <p> tag is added inside the list tag
(s).

NOTE You can also access this option from the Home ribbon (by clicking ), or by
clicking the floating icon shown when you start a new list.

4. Click to save your work.
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EXAMPLE You have changed your default settings to not automatically include paragraph
items within each list item. However, you create a list and decide you want to add some
new content between steps.

In the structure bars shown to the left of the content, notice that the entire list has an <ol>
tag, and each line in the list has an <li> tag.

Each time you press ENTER after a line, a new <li> tag is created.
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You want to add some additional content after step 2, before continuing with step 3. So you
right-click that li tag bar and select Make Paragraph Item(s). This turns step 2 into a
paragraph item (i.e., a <p> tag is added inside the <li> tag in that line).
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At the end of step 2, you press ENTER, creating a new line with a number.

Then you press BACKSPACE. Now you see a yellow icon and the number is removed.
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So you type the new content.
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How to Return a Paragraph Item in a List to a
Simple Item

1. Click in the list where a paragraph item exists (an <li> tag followed by a <p> tag).

2. If the tag block bars are not shown to the left of the content, click at the bottom of the
editor.

3. Right-click the list tag bar (e.g., ol, ul, li, dd) that is next to a line where a paragraph item exists
(e.g., an <li> tag followed by a <p> tag). Then select Make Simple Item(s). The <p> tag is
removed.

NOTE You can also access this option from the Home ribbon (by clicking ), or by
clicking the floating icon shown when you start a new list.

4. Click to save your work.
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How to Change Default Settings for Paragraph
and Simple Items
In the Options dialog, you can specify how you want lists to behave initially when you create a new
list (i.e., with <p> tags or without them).

1. Select File > Options. The Options dialog opens.

NOTE You can also open this dialog by clicking the floating icon shown when you
start a new list, then selecting Set Default.

2. Select the XML Editor tab.

3. In the Defaults section, click the List or Definition List drop-down and select either Paragraph
(if you want <p> tags initially) or Simple (if you do not).

4. Click OK.
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Setting Page and Column Breaks for
Lists

You can apply a page or column break to lists or items within them. You might do this if you want a
list to end with a particular item on one page and begin with another list item on the next page or
column, without interrupting the flow of the list. You can do this by setting manual page breaks
(Insert > Page Break) or by using style settings. For example, you could create a class of the li style
and you could call it something like "PageBreakBefore" (li.PageBreakBefore). For most items in a
list, you could use the parent li style, but if you want a page break to occur on a particular list item,
you could apply your li.PageBreakBefore style to it. This feature is used for print-based output.
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How to Insert a Manual Page Break for a List
1. Place your cursor on an empty line in the list where you want to insert the page break. When

you generate print-based output, the break occurs after this insertion point.

If this is between list items, you will initially see a number or bullet next to that empty line.

2. If there is a <p> tag within the <li> tag, remove the <p> tag by making it a simple list item. To
do this, right-click the li structure bar and select Make Simple Item(s).

3. Select Insert > Page Break.

A gray bar is displayed in the XML Editor, and the number or bullet is removed. The gray bar is
also represented by a structure bar on the left side of the XML Editor. You can apply
conditions to the break, in case it should be used in some outputs but not others.
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In the code, Flare Desktop uses the MadCap:pageBreak element where a page break is
inserted.
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How to Use a Style to Set a Page or Column
Break for Lists

1. From the Content Explorer, open the stylesheet that you want to modify.

2. From the Medium drop-down in the Stylesheet Editor, make sure the proper medium is
selected before you begin. In the Advanced view, you can open multiple mediums at once;
you just need to look at the title at the top of the medium pane and make sure you are
working in the correct one. If you are not using stylesheet mediums for your different outputs
or if you want all mediums to have the same settings, just leave the medium set to default
and continue.

Mediums can be used if you want to use one group of settings for online output types and
another group of settings for print-based output types. For example, you might use the
default medium for your online outputs and the print medium for your print outputs.

Please note that Flare Desktop remembers the last medium that you used when working in
the stylesheet, so it may or may not be the one that you want to use the next time around.

3. In the local toolbar, make sure the first button displays . If the button displays
instead, then click it.

4. In the upper-left corner of the editor, click in the drop-down field and select
.

5. Select a list style. For example, you can select ol for ordered (numbered) lists, ul for
unordered (e.g., bullet) lists, or li for individual list items. You can select the parent style (e.g.,
li), or you can select a class that you may have created for that tag (e.g., li.Bold, li.Italic).

6. From the Show drop-down list on the upper-right side of the editor, select .

7. (Optional) You can use the toggle button in the local toolbar to show properties below in a
group view or an alphabetical view .

8. If you are using the grouped view, expand the PrintSupport group.

9. Do any of the following:

n To the right of page-break-before, click and select one of the options for setting a
page break before the list item.

l always A page break will always occur before the list item.

l auto A page break will neither be forced nor prevented before the list item.
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l avoid A page break will not occur before the list item.

l inherit The page break setting of the parent tag is used.

l left One or two page breaks will occur before the list item so that the next page is
formatted as a left page.

l right One or two page breaks will occur before the list item so that the next page is
formatted as a right page.

n To the right of page-break-after, click and select one of the options for setting a
page break after the list item:

l always A page break will always occur after the list item.

l auto A page break will neither be forced nor prevented after the list item.

l avoid A page break will not occur after the list item.

l inherit The page break setting of the parent tag is used.

l left One or two page breaks will occur after the list item so that the next page is
formatted as a left page.

l right One or two page breaks will occur after the list item so that the next page is
formatted as a right page.

n To the right of page-break-inside, click and select one of the options for setting a
page break inside the "rendering box" of the list item:

l auto A page break will neither be forced nor prevented inside the rendering box of
the list item.

l avoid A page break will not occur inside the rendering box of the list item.

l inherit The page break setting of the parent tag is used.

10. Click to save your work.

11. In the content file where you have inserted a list, click the structure bar where you want to
apply the style. In other words, if you want to apply it to the entire list, click the ol or ul bar. If
you want to apply it to a list item, click the li bar. Then select the style class (e.g., from the
Home ribbon or Styles window pane).
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NOTE Let's say you've created a class for the li style (e.g., li.PageBreakBefore) and you've
specified a page break for it. Suppose you want to apply that style class to an item in one of
your lists so that it starts on the next page. However, you also want to add a paragraph tag
to it (e.g., so that you can add a comment after the item without altering the overall
sequence of the list). In that case, you should make sure to apply the list style class to the
item first and then add the paragraph tag to it afterward.

NOTE It is also possible to use styles to set breaks on tables.
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Editing List Styles
You can modify the look of lists by making adjustments to the tags and style classes used for them.
By editing list styles, you can affect things such as the alignment, background, bullet images, and
indentation of lists.

List Style Tasks
The following can be modified by using list styles:

n "Aligning Lists" on page 47

n "Setting the Background for Lists" on page 49

n "Setting Borders for Lists" on page 51

n "Selecting Images for List Bullets" on page 53

n "Indenting Lists" on page 55

n "Setting Line Spacing for Lists" on page 58

n "Specifying a List Type for a Style" on page 59

n "Setting Spacing Above and Below in Lists" on page 65
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Types of List Styles
When you modify the look of lists that you create, you can modify any of the following kinds of
styles in your stylesheet. Each of these styles is used to control a different aspect of a list. You can
also create classes of these styles if you want to have multiple lists with different looks. For
example, you could create one class of the ul style and call it "Indent1Inch," and then create another
class of that style and call it "Indent2Inches."

n li Modifies individual list items.

n ol Modifies an entire numbered ("ordered") list, such as a set of steps in a procedure.

EXAMPLE Here is a sample ordered list.

1. First do this.

2. Then do that.

3. Then do the other thing.

Here is how the tag structure for that ordered list would look behind the scenes.

<ol>
<li>First do this.</li>
<li>Then do that.</li>
<li>Then do the other thing.</li>

</ol>

Therefore, if you applied a 1-pixel border to the li style, each list item would have a
border around it. But if you applied the border to the ol style, the entire list would have
a border around it.
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n ul Modifies an entire bulleted ("unordered") list.

EXAMPLE Here is a sample unordered list.

l This is the first chore I have to do today.

l This is the second chore I have to do today.

l This is the third chore I have to do today.

Here is how the tag structure for that ordered list would look behind the scenes.

<ul>
<li>This is the first chore I have to do today.</li>
<li>This is the second chore I have to do today.</li>
<li>This is the third chore I have to do today.</li>

</ul>

Therefore, if you applied a 1-pixel border to the li style, each list item would have a
border around it. But if you applied the border to the ul style, the entire list would have
a border around it.

n dl Modifies a definition list.

n dt Modifies terms in a definition list.
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n dd Modifies definitions in a definition list.

EXAMPLE Here is a sample definition list.

Basketball

A game played with a hoop.

Football

A game with large men crashing into each other.

Olympic Curling

Nobody is exactly sure what this is.

Here is how the tag structure for that definition list might look behind the scenes.

<dl>
<dt>Basketball</dt>
<dd>A game played with a hoop.</dd>
<dt>Football</dt>
<dd>A game with large men crashing into each other.</dd>
<dt>Olympic Curling</dt>
<dd>Nobody is exactly sure what this is.</dd>

</dl>

In this example, the font weight of the dt style is bold, and the dd style is indented by
20 pixels.
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Custom List Format Styles
For PDF output, you can create and edit lists with custom formats up to 10 levels deep. Custom
formats allow you to quickly create lists (especially multi-level lists) that already have a certain look
applied as you indent in the list to create new levels. For each level in a custom list format, you can
specify whether to use an ordered (numbered) or unordered (bulleted) style, select a custom bullet
image, insert characters or symbols, and choose formatting (e.g., bold, color, size). The formats
that you create are written to your stylesheet. See "Creating Custom List Formats" on page 68 and
"Editing Custom List Formats" on page 83.

Because custom list formats are written to your stylesheet as complex selectors, you can edit these
formats in the Advanced view of the Stylesheet Editor.

When you view list styles in the Stylesheet Editor, you will see custom formats displayed as classes
under the respective ol and ul parent styles, depending on whether the first level of that format is an
ordered or unordered list. However, these classes are really limited to the list style type for each.
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The real editing can take place in a special section called "(Custom Lists)," where all ordered and
unordered custom list formats are grouped together.

As you expand each custom list format, you will see nodes for each level that you have formatted.
You can change the list style type (e.g., decimal, lower-alpha) or select a custom bullet image on
these nodes.

And under each level is a pseudo-element called "(marker)." A marker is the combination of the
content and formatting for that level. It is usually a number, letter of the alphabet, symbol, or
character, sometimes with punctuation, such as a period. This node is where the bulk of the editing
takes place on a custom list format.
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What’s Noteworthy?

NOTE For more information on the CSS specification for the marker pseudo-element, see:

http://dev.w3.org/csswg/css-lists/#marker-pseudo-element

NOTE By right-clicking on the name of a custom style and selecting Edit Custom Format,
you can open the Edit List Format dialog and make your changes there instead.
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Aligning Lists
You can format lists or items within them so that the text is aligned right, left, centered, or
justified. This can be done through styles or by using local formatting. Using styles is usually
recommended because the setting is automatically applied to any content using that style
throughout the project, whereas local formatting affects only the particular content that you are
working on.

How to Use a Style to Align a List
1. From the Content Explorer, open the stylesheet that you want to modify.

2. From the Medium drop-down in the Stylesheet Editor, make sure the proper medium is
selected before you begin. In the Advanced view, you can open multiple mediums at once;
you just need to look at the title at the top of the medium pane and make sure you are
working in the correct one. If you are not using stylesheet mediums for your different outputs
or if you want all mediums to have the same settings, just leave the medium set to default
and continue.

Mediums can be used if you want to use one group of settings for online output types and
another group of settings for print-based output types. For example, you might use the
default medium for your online outputs and the print medium for your print outputs.

Please note that Flare Desktop remembers the last medium that you used when working in
the stylesheet, so it may or may not be the one that you want to use the next time around.

3. In the local toolbar, make sure the first button displays . If the button displays
instead, then click it.

4. In the upper-left corner of the editor, click in the drop-down field and select
.

5. Select a list style. For example, you can select ol for ordered (numbered) lists, ul for
unordered (e.g., bullet) lists, or li for individual list items. You can select the parent style (e.g.,
li), or you can select a class that you may have created for that tag (e.g., li.Bold, li.Italic).

6. From the Show drop-down list on the upper-right side of the editor, select .

7. (Optional) You can use the toggle button in the local toolbar to show properties below in a
group view or an alphabetical view .

8. If you are using the grouped view, expand the Block group.
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9. To the right of text-align, click , and select one of the alignment options.

n center Aligns the text on the center of the page or column.

n inherit Uses the alignment setting of the parent tag.

n justify Aligns the text so that it is flush with both the left and right side.

n left Aligns the text on the left side of the page or column.

n right Aligns the text on the right side of the page or column.

10. Click to save your work.
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Setting the Background for Lists
You can set a background color and/or image on lists or items within them.

How to Use a Style to Add a Background to a List
1. From the Content Explorer, open the stylesheet that you want to modify.

2. From the Medium drop-down in the Stylesheet Editor, make sure the proper medium is
selected before you begin. In the Advanced view, you can open multiple mediums at once;
you just need to look at the title at the top of the medium pane and make sure you are
working in the correct one. If you are not using stylesheet mediums for your different outputs
or if you want all mediums to have the same settings, just leave the medium set to default
and continue.

Mediums can be used if you want to use one group of settings for online output types and
another group of settings for print-based output types. For example, you might use the
default medium for your online outputs and the print medium for your print outputs.

Please note that Flare Desktop remembers the last medium that you used when working in
the stylesheet, so it may or may not be the one that you want to use the next time around.

3. In the local toolbar, make sure the first button displays . If the button displays
instead, then click it.

4. In the upper-left corner of the editor, click in the drop-down field and select
.

5. Select a list style. For example, you can select ol for ordered (numbered) lists, ul for
unordered (e.g., bullet) lists, or li for individual list items. You can select the parent style (e.g.,
li), or you can select a class that you may have created for that tag (e.g., li.Bold, li.Italic).

6. From the Show drop-down list on the upper-right side of the editor, select .

7. (Optional) You can use the toggle button in the local toolbar to show properties below in a
group view or an alphabetical view .

8. If you are using the grouped view, expand the Background group. 
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9. Locate the background property that you want to change.

TO SET A COLOR FOR THE BACKGROUND
n To the right of background-color, click , and select a color. For advanced color

options, click and use the fields in the Color Picker dialog, or click to select a
color already used elsewhere on your screen. You can use the Color Picker to select a
CSS variable.

TO ADD AN IMAGE TO THE BACKGROUND

a. To the right of background-image, click . The Insert Image dialog opens.

b. Select an image file to insert. You can do this in one of the following ways.

n Select an image already in the project by finding and selecting it in the built-in
tree.

n Click to find and select an image file outside of the project.

NOTE If you want to select an image file recently inserted into your project,
click the down arrow in the field next to the button, and select the file from
the list.

c. If you want the background image to repeat, click to the right of background-repeat
and select one of the options (definitions from http://www.w3.org).

n no-repeat The image is not repeated: only one copy of the image is drawn.

n repeat The image is repeated both horizontally and vertically.

n repeat-x The image is repeated horizontally only.

n repeat-y The image is repeated vertically only.

10. Click to save your work.
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Setting Borders for Lists
You can add borders around lists or items within them. Borders can be added on any side (left,
right, top, bottom), or all around.

How to Use a Style to Add a Border to a List
1. From the Content Explorer, open the stylesheet that you want to modify.

2. From the Medium drop-down in the Stylesheet Editor, make sure the proper medium is
selected before you begin. In the Advanced view, you can open multiple mediums at once;
you just need to look at the title at the top of the medium pane and make sure you are
working in the correct one. If you are not using stylesheet mediums for your different outputs
or if you want all mediums to have the same settings, just leave the medium set to default
and continue.

Mediums can be used if you want to use one group of settings for online output types and
another group of settings for print-based output types. For example, you might use the
default medium for your online outputs and the print medium for your print outputs.

Please note that Flare Desktop remembers the last medium that you used when working in
the stylesheet, so it may or may not be the one that you want to use the next time around.

3. In the local toolbar, make sure the first button displays . If the button displays
instead, then click it.

4. In the upper-left corner of the editor, click in the drop-down field and select
.

5. Select a list style. For example, you can select ol for ordered (numbered) lists, ul for
unordered (e.g., bullet) lists, or li for individual list items. You can select the parent style (e.g.,
li), or you can select a class that you may have created for that tag (e.g., li.Bold, li.Italic).

6. From the Show drop-down list on the upper-right side of the editor, select .

7. (Optional) You can use the toggle button in the local toolbar to show properties below in a
group view or an alphabetical view .

8. If you are using the grouped view, expand the Border group. 
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9. Locate and select the border property you want to change. Each side (bottom, left, right, top)
has separate properties that you can set for the color, style, and width (e.g., border-bottom-
style). You can set these properties individually, or you can set the primary property for each
side (e.g., border-bottom), which lets you specify the color, style, and width in one place. If
you plan to have the same settings for all sides, you can use the main border property to set
the color, style, and width the same. The border-radius properties let you create curved edges
on the border by providing horizontal and vertical values.

When you click next to a border property, a popup appears. Use the fields in the popup to
define additional properties such as color, width, style, and thickness, then click OK.

10. Click to save your work.
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Selecting Images for List Bullets
You can change the image used for bullets in lists. For example, if you have a small check mark
icon that you want to use instead of round bullets, you can select your image.

How to Use a Style to Select an Image for List Bullets
1. From the Content Explorer, open the stylesheet that you want to modify.

2. From the Medium drop-down in the Stylesheet Editor, make sure the proper medium is
selected before you begin. In the Advanced view, you can open multiple mediums at once;
you just need to look at the title at the top of the medium pane and make sure you are
working in the correct one. If you are not using stylesheet mediums for your different outputs
or if you want all mediums to have the same settings, just leave the medium set to default
and continue.

Mediums can be used if you want to use one group of settings for online output types and
another group of settings for print-based output types. For example, you might use the
default medium for your online outputs and the print medium for your print outputs.

Please note that Flare Desktop remembers the last medium that you used when working in
the stylesheet, so it may or may not be the one that you want to use the next time around.

3. In the local toolbar, make sure the first button displays . If the button displays
instead, then click it.

4. In the upper-left corner of the editor, click in the drop-down field and select
.

5. Select a list style. For example, you can select ol for ordered (numbered) lists, ul for
unordered (e.g., bullet) lists, or li for individual list items. You can select the parent style (e.g.,
li), or you can select a class that you may have created for that tag (e.g., li.Bold, li.Italic).

6. From the Show drop-down list on the upper-right side of the editor, select .

7. (Optional) You can use the toggle button in the local toolbar to show properties below in a
group view or an alphabetical view .

8. If you are using the grouped view, expand the List group. 

9. To the right of list-style-image, click . The Insert Image dialog opens.
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10. Select an image file to insert. You can do this in one of the following ways.

n Select an image already in the project by finding and selecting it in the built-in tree.

n Click to find and select an image file outside of the project.

NOTE If you want to select an image file recently inserted into your project, click the
down arrow in the field next to the button, and select the file from the list.

11. Click to save your work.

NOTE For PDF output, you can also select a bullet image when creating a custom list
format. See "Creating Custom List Formats" on page 68.
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Indenting Lists
You can indent lists or items within them so that they start or end at a certain distance from the left
or right side of the window or page frame.

How to Use a Style to Indent Lists
1. From the Content Explorer, open the stylesheet that you want to modify.

2. From the Medium drop-down in the Stylesheet Editor, make sure the proper medium is
selected before you begin. In the Advanced view, you can open multiple mediums at once;
you just need to look at the title at the top of the medium pane and make sure you are
working in the correct one. If you are not using stylesheet mediums for your different outputs
or if you want all mediums to have the same settings, just leave the medium set to default
and continue.

Mediums can be used if you want to use one group of settings for online output types and
another group of settings for print-based output types. For example, you might use the
default medium for your online outputs and the print medium for your print outputs.

Please note that Flare Desktop remembers the last medium that you used when working in
the stylesheet, so it may or may not be the one that you want to use the next time around.

3. In the local toolbar, make sure the first button displays . If the button displays
instead, then click it.

4. In the upper-left corner of the editor, click in the drop-down field and select
.

5. Select a list style. For example, you can select ol for ordered (numbered) lists, ul for
unordered (e.g., bullet) lists, or li for individual list items. You can select the parent style (e.g.,
li), or you can select a class that you may have created for that tag (e.g., li.Bold, li.Italic).

6. From the Show drop-down list on the upper-right side of the editor, select .

7. (Optional) You can use the toggle button in the local toolbar to show properties below in a
group view or an alphabetical view .

8. If you are using the group view, expand the Box group. 
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9. To the right of margin-left or padding-left, click . In the popup, enter the distance that the
list or list item will be indented. Click OK.

NOTE Both margins and padding can affect the space around elements. The margin
controls the amount of space from the edge of the page or viewing device to the
edge of the "container" holding the element. Padding controls the amount of space
from the edge of the element itself and the container holding it. Therefore, if you
seem to be experiencing more space than you expected, you might check to see if
you have values entered for both the margin and padding.

10. To the right of margin-right, click . In the popup, enter the distance that the list or list item
will be indented from the right side of the page. Click OK.

11. Click to save your work.
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NOTE Different browsers may treat margin and padding settings differently. For example,
Firefox honors padding settings more than it honors margin settings.

NOTE A <div> tag is a good way to indent lots of content. For example, you might have a
section of content containing four paragraphs, a numbered list, and an image. Rather than
creating special style classes for all of those different elements with an indentation setting
(e.g., margin-left or padding-left) on each, you can place your indentation setting on the div
style. That way, any content contained within that <div> tag will be indented accordingly.
For more information about tag groups, see the Help system.
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Setting Line Spacing for Lists
You can specify the amount of spacing between lines of text in a list.

How to Use a Style to Set Line Spacing for Lists
1. From the Content Explorer, open the stylesheet that you want to modify.

2. From the Medium drop-down in the Stylesheet Editor, make sure the proper medium is
selected before you begin. In the Advanced view, you can open multiple mediums at once;
you just need to look at the title at the top of the medium pane and make sure you are
working in the correct one. If you are not using stylesheet mediums for your different outputs
or if you want all mediums to have the same settings, just leave the medium set to default
and continue.

Mediums can be used if you want to use one group of settings for online output types and
another group of settings for print-based output types. For example, you might use the
default medium for your online outputs and the print medium for your print outputs.

3. In the local toolbar, make sure the first button displays . If the button displays
instead, then click it.

4. In the upper-left corner of the editor, click in the drop-down field and select
.

5. Select a list style. For example, you can select ol for ordered (numbered) lists, ul for
unordered (e.g., bullet) lists, or li for individual list items. You can select the parent style (e.g.,
li), or you can select a class that you may have created for that tag (e.g., li.Bold, li.Italic).

6. From the Show drop-down list on the upper-right side of the editor, select .

7. (Optional) You can use the toggle button in the local toolbar to show properties below in a
group view or an alphabetical view .

8. If you are using the grouped view, expand the Font group.

9. To the right of line-height, click and use the fields in the popup to set the amount of space
between lines. When you are finished, click OK.

10. Click to save your work.

TIP Make sure the line height is equal to or greater than the font size.
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Specifying a List Type for a Style
You can specify the type of list (e.g., circle, square, decimal, upper alpha) for a style.

How to Use a Style to Select a List Type
1. From the Content Explorer, open the stylesheet that you want to modify.

2. From the Medium drop-down in the Stylesheet Editor, make sure the proper medium is
selected before you begin. In the Advanced view, you can open multiple mediums at once;
you just need to look at the title at the top of the medium pane and make sure you are
working in the correct one. If you are not using stylesheet mediums for your different outputs
or if you want all mediums to have the same settings, just leave the medium set to default
and continue.

Mediums can be used if you want to use one group of settings for online output types and
another group of settings for print-based output types. For example, you might use the
default medium for your online outputs and the print medium for your print outputs.

Please note that Flare Desktop remembers the last medium that you used when working in
the stylesheet, so it may or may not be the one that you want to use the next time around.

3. In the local toolbar, make sure the first button displays . If the button displays
instead, then click it.

4. In the upper-left corner of the editor, click in the drop-down field and select
.

5. Select a list style. For example, you can select ol for ordered (numbered) lists, ul for
unordered (e.g., bullet) lists, or li for individual list items. You can select the parent style (e.g.,
li), or you can select a class that you may have created for that tag (e.g., li.Bold, li.Italic).

6. From the Show drop-down list on the upper-right side of the editor, select .

7. (Optional) You can use the toggle button in the local toolbar to show properties below in a
group view or an alphabetical view .

8. If you are using the grouped view, expand the List group. 
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9. To the right of list-style-type, click and select a list type. There are several from which to
choose. You may want to select different ones and view the results before settling on the one
you want.

Also, if the list-style-image field is pointing to an image, select (default) from that field to
remove the image reference; otherwise, it will override the option you should from the list-
style-type field.

10. Click to save your work.

CHAPTER 3  60



Advanced Selectors and Lists
An advanced (or "complex") selector lets you format content based on very specific criteria. You
can use advanced selectors when creating lists to automatically use different styles for each level
in a multi-level list. For example, you could create a multi-level numbered list that uses a regular
number in bold for the first-level ol, a lower-alpha number in italics for the second-level ol (i.e., the
"ol ol" advanced selector), and a lower-Roman number for the third-level ol (i.e., the "ol ol ol"
advanced selector). It could also be a combination numbered and bulleted list. For example, in the
"ol ul ol ol" advanced selector, a numbered list is used for the first, third, and fourth levels, and a
bulleted list is used for the second level.

EXAMPLE Here is an example of a multi-level ordered list.

You want to add an advanced selector so each level of the list will use a different style. To
do this, you need to create (or edit) three different styles: the ol style, the ol ol advanced
selector (for <ol> tags residing inside another <ol> tag), and the ol ol ol advanced selector
(for <ol> tags residing inside two other <ol> tags).
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You already have an ol style in your stylesheet, so you can edit this style. This will affect the
first level of your list.
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Now you create a new ol ol advanced selector, if it doesn't already exist. This selector will
be found in the Complex Selectors group in the Stylesheet Editor. You edit the style
properties for second-level lists.
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Now you create another advanced selector: ol ol ol. You edit the style properties for third-
level lists.

When you view the multi-level list in your topic, it looks like this:
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Setting Spacing Above and Below in Lists
You can specify the amount of spacing above and below lists or items within them.

How to Use a Style to Set Spacing Above and Below
Lists

1. From the Medium drop-down in the Stylesheet Editor, make sure the proper medium is
selected before you begin. In the Advanced view, you can open multiple mediums at once;
you just need to look at the title at the top of the medium pane and make sure you are
working in the correct one. If you are not using stylesheet mediums for your different outputs
or if you want all mediums to have the same settings, just leave the medium set to default
and continue.

Mediums can be used if you want to use one group of settings for online output types and
another group of settings for print-based output types. For example, you might use the
default medium for your online outputs and the print medium for your print outputs.

Please note that Flare Desktop remembers the last medium that you used when working in
the stylesheet, so it may or may not be the one that you want to use the next time around.

2. In the local toolbar, make sure the first button displays . If the button displays
instead, then click it.

3. In the upper-left corner of the editor, click in the drop-down field and select
.

4. Select a list style. For example, you can select ol for ordered (numbered) lists, ul for
unordered (e.g., bullet) lists, or li for individual list items. You can select the parent style (e.g.,
li), or you can select a class that you may have created for that tag (e.g., li.Bold, li.Italic).

5. From the Show drop-down list on the upper-right side of the editor, select .

6. (Optional) You can use the toggle button in the local toolbar to show properties below in a
group view or an alphabetical view .

7. If you are using the group view, expand the Box group.

8. To the right of margin-bottom, click and set the amount of space below the list or list item.
When you are finished, click OK.

9. To the right of margin-top, click and set the amount of space above the list or list item.
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When you are finished, click OK.

10. Click to save your work.

NOTE Different browsers may treat margin and padding settings differently. For example,
Firefox honors padding settings more than it honors margin settings.
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CHAPTER 4

Other Activities for Lists
In addition to the main activities, there are some other tasks you might perform regarding this
feature.

This chapter discusses the following:

Creating Custom List Formats 68

Editing Custom List Formats 83

Continuing the Sequence of Lists 93

Merging Lists 96

Restarting Numbering in Lists 98

Reversing Lists 99

Sorting Lists 100

Unbinding Lists 101
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Creating Custom List Formats
Supported In:

For PDF output, you can create and edit lists with custom formats up to 10 levels deep. Custom
formats allow you to quickly create lists (especially multi-level lists) that already have a certain look
applied as you indent in the list to create new levels. For each level in a custom list format, you can
specify whether to use an ordered (numbered) or unordered (bulleted) style, select a custom bullet
image, insert characters or symbols, and choose formatting (e.g., bold, color, size). The formats
that you create are written to your stylesheet.

IMPORTANT At this time, custom list formats are supported only in PDF output. After
browsers begin to support the CSS3 marker element that makes custom list formats
possible, this feature will automatically be supported in browser-based outputs as well.
Until then, if you want to generate a browser-based output, you should use the standard
method for creating lists instead.
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How to Create a Custom List Format
1. Place your cursor in the document where you want to create a list.

2. Select Home > (down arrow) and choose Custom List Format > Create Custom Format.
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3. Use the Create New List Format dialog to specify the type of counter (e.g., decimals, upper-
roman, lower-alpha), custom characters and images, and the look for each level of the list
format. (You can use only one counter per level in the format.)

n Name Give your custom list format a name.

n Comment You can add an internal comment, such as the purpose of the list format.

n Stylesheet This displays the stylesheet associated with your primary target. Styles
created as a result of your custom list format are added to this stylesheet.

n Level Select the level of the list that you want to work on. When a level is selected, any
settings you choose are applied only to that level.

n Content This field becomes populated based on settings you choose using the buttons
next to this field. It is a good idea to begin by clicking the first button to the right (i.e.,

) and selecting a list type or image first (see below). Then use the other options as
necessary.

You can also type directly into this field.
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NOTE Any text typed directly in this field is supported only in PDF output. If you
enter any text, the default list markers (e.g., bullets, numbers) are instead
displayed in non-PDF outputs.

n Select the type of list. If you click the down arrow, you can select any of the
following:

Type of List
What is Added to the Content
Field?

Bullet list Nothing

Numbered list {n}.

Lower-alpha numbered list {a}.

Upper-alpha numbered list {A}.

Lower-Roman numbered list {r}.

Upper-Roman numbered list {R}.

Select custom bullet image The path to the image file

CHAPTER 4  71



n You can click this button to insert a special character or symbol.

NOTE Custom list characters are supported only in PDF output. If you add
characters or symbols to the Content field, the default list markers (e.g.,
bullets, numbers) are instead displayed in non-PDF outputs. However, custom
bullet images are supported in all output formats.

n You can click this button to open the Font Properties dialog. This lets you change
the look of the list marker, such as the font size or type, color, and effects.

4. Click OK. The dialog closes and a list is started with the first level shown. Whenever you press
Tab or click the indent button , the next level is created in the list. You can click the outdent
button in the Home ribbon to move back out to higher levels in the list.

5. Click to save your work.
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Custom List Formats and Styles
When you create a custom list format, a complex selector (a special type of style) is added to your
stylesheet. In the Stylesheet Editor, you can see your custom list formats under (Complex
Selectors), as well as under (Custom Lists).
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A custom list format might look something like the following when looking at the stylesheet in the
Internal Text Editor.

You can edit these styles whenever you like. See "Editing Custom List Formats" on page 83.
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Applying Custom List Formats
After you create a custom list format, you can open a topic or snippet in the XML Editor and select
that format when creating a new list.
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You can also change an existing list to another custom format by right-clicking the ol (ordered list)
or ul (unordered) structure bar and choosing the format from the context menu.
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EXAMPLE You want many of your lists to have a format where the first level of the list
uses blue numbers in bold font with a size of 1.5 em (which is similar to 150%). The second
level needs to be lower-alpha numbers in red italic font with a size of 1.0 em (which is
similar to 100%). And the third level should be unordered format with a green image
representing each bullet.

For the first level, you might do this:
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For the second level, you might do this:

For the third level, you might do this:
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As soon as the format is created, the beginning of the list is seen in the XML Editor with the
first level shown.
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Type content and press ENTER, just like you would for any other list. When you want to
enter content for a second level in the list, press Tab on your keyboard. The formatting
automatically changes to the red lower-alpha format.
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Type content for the second-level list items, pressing ENTER after each line. When you
want to enter content for a third level in the list, press Tab on your keyboard. Because you
are moving from an ordered list to an unordered list at this point, the structure bar changes
to a <ul> tag and the formatting for the third level changes to the green image.
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Type content for the third-level list items, pressing ENTER after each line. When you want to
return to the second-level list, click the Outdent button in the Home ribbon.

Now you're back at the second level. Type content for any second-level list items. When you
want to return to the first-level list, click the Outdent button in the Home ribbon.

You should now be back at the first level, where you can continue the list content.
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Editing Custom List Formats
Supported In:

After you create custom list formats, you can edit them in a couple of ways.

How to Use the Edit List Format Dialog
This is the easier option for users who are not as experienced with cascading stylesheets (CSS). It
is essentially the same as the Create New List Format dialog, which is used when creating a
custom list format. The only difference is that you are adjusting existing settings, rather than
adding everything from scratch.

1. Open a content file containing a custom format list.

2. If the tag block bars are not shown to the left of the content, click at the bottom of the
editor.

3. Click the outermost (i.e., first level) structure bar (ol or ul) for the list.

4. Select Home > (down arrow) and choose Custom List Format > Edit Custom List Format.
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5. Use the Edit List Format make changes to the format.

n Name Give your custom list format a name.

n Comment You can add an internal comment, such as the purpose of the list format.

n Stylesheet This displays the stylesheet associated with your primary target. Styles
created as a result of your custom list format are added to this stylesheet.

n Level Select the level of the list that you want to work on. When a level is selected, any
settings you choose are applied only to that level.

n Content This field becomes populated based on settings you choose using the buttons
next to this field. It is a good idea to begin by clicking the first button to the right (i.e.,

) and selecting a list type or image first (see below). Then use the other options as
necessary.

You can also type directly into this field.

NOTE Any text typed directly in this field is supported only in PDF output. If you
enter any text, the default list markers (e.g., bullets, numbers) are instead
displayed in non-PDF outputs.
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n Select the type of list. If you click the down arrow, you can select any of the
following:

Type of List
What is Added to the Content
Field?

Bullet list Nothing

Numbered list {n}.

Lower-alpha numbered list {a}.

Upper-alpha numbered list {A}.

Lower-Roman numbered list {r}.

Upper-Roman numbered list {R}.

Select custom bullet image The path to the image file

n You can click this button to insert a special character or symbol.

NOTE Custom list characters are supported only in PDF output. If you add
characters or symbols to the Content field, the default list markers (e.g.,
bullets, numbers) are instead displayed in non-PDF outputs. However, custom
bullet images are supported in all output formats.

n You can click this button to open the Font Properties dialog. This lets you change
the look of the list marker, such as the font size or type, color, and effects.
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6. Click OK. The dialog closes and any lists associated in your project with that custom format
are automatically changed.

7. Click to save your work.
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How to Edit Custom List Format Styles
When you view list styles in the Stylesheet Editor, you will see custom formats displayed as classes
under the respective ol and ul parent styles, depending on whether the first level of that format is an
ordered or unordered list. However, these classes are really limited to the list style type for each.

The real editing can take place in a special section called "(Custom Lists)," where all ordered and
unordered custom list formats are grouped together.
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1. From the Content Explorer, open the stylesheet that you want to modify.

2. From the Medium drop-down in the Stylesheet Editor, make sure the proper medium is
selected before you begin. In the Advanced view, you can open multiple mediums at once;
you just need to look at the title at the top of the medium pane and make sure you are
working in the correct one. If you are not using stylesheet mediums for your different outputs
or if you want all mediums to have the same settings, just leave the medium set to default
and continue.

Mediums can be used if you want to use one group of settings for online output types and
another group of settings for print-based output types. For example, you might use the
default medium for your online outputs and the print medium for your print outputs.

Please note that Flare Desktop remembers the last medium that you used when working in
the stylesheet, so it may or may not be the one that you want to use the next time around.

3. In the local toolbar, make sure the first button displays . If the button displays
instead, then click it.

4. In the upper-left corner of the editor, click in the drop-down field and select
.

5. Expand (Custom Lists).

6. As you expand each custom list format, you will see nodes for each level that you have
formatted. You can change the list style type (e.g., decimal, lower-alpha) or select a custom
bullet image on these nodes.
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And under each level is a pseudo-element called "(marker)." A marker is the combination of
the content and formatting for that level. It is usually a number, letter of the alphabet, symbol,
or character, sometimes with punctuation, such as a period. This node is where the bulk of
the editing takes place on a custom list format.

7. Select the level or marker node that you want to edit.

8. From the Show drop-down list on the upper-right side of the editor, select
. The most relevant properties for that style are shown on the

right side of the editor.

9. (Optional) You can use the toggle button in the local toolbar to show properties below in a
group view or an alphabetical view .

CHAPTER 4  89



10. Locate the property you want to change.

11. The area to the right of the property is used for selecting and entering values. If you know
how to enter the information correctly, you can click in the value field and type it
directly. Otherwise, click the ellipsis button to the right of the property. Depending on the
type of property, the appropriate controls and options display, allowing you to choose or enter
values (e.g., select from a drop-down list, click a button, complete fields in a dialog or
popup). If you completed values in a popup, click OK at the bottom of the box.

The most common settings that you are likely to change include:

n color

n content

n font-size

n font-style

n font-weight

n list-style-image

n list-style-type

If you do not see the property listed that you want to change, click in the Show drop-down and
choose another filter (e.g., All Properties).

For more information about common list properties, see "Editing List Styles" on page 39.

12. Click to save your work.

NOTE For more information on the CSS specification for the marker pseudo-element, see:

http://dev.w3.org/csswg/css-lists/#marker-pseudo-element
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NOTE By right-clicking on the name of a custom style and selecting Edit Custom Format,
you can open the Edit List Format dialog and make your changes there instead.
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How to Reset the Style Class
If you no longer want to use a custom list format and want to return to the default style settings for
the list, you can reset the style class.

1. Click in the list.

2. Do one of the following, depending on the part of the user interface you are using:

n Home Ribbon In the Paragraph section, click the down arrow on the list button .
Then select Custom List Format > (reset class).

n Format Menu Select List > Custom List Format > (reset class).

n Structure Bar Make sure the structure bars are turned on. Right-click any of the list
structure bars (ol or ul) representing levels of the list. From the context menu, select
List Type > Custom List Format > (reset class).
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Continuing the Sequence of Lists
If you have created multiple lists in a topic, you can continue the sequence from one to the other.
This ensures that the next list you create in the topic starts with the next number in the sequence of
the list above (even if the two lists are separated by other content).

EXAMPLE You have a numbered list from 1 to 10 at the top of your topic and you add a
few regular paragraphs (not in a list) after it. If you start another numbered list and select
this option, the new list will start at 11.

When you apply the Continue Sequence option to a list, not only will that list continue the
numbering of the previous list, but it will also grab the style attributes from the other list.

EXAMPLE You have a document with two lists, like this:

These two lists have been styled using the stylesheet. The first list is using a style class
called "ol.Red," which is using a red font. The second list is using a style class called
"ol.Blue," which is using a blue font.
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You can alter the numbering of the second list, so that it continues where the first list
ended. To do this, click in the second list. Right-click on the ol structure bar to the left of
that list, and from the context menu, select Continue Sequence.
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How to Continue the Sequence of Lists
1. Place your cursor somewhere in the lower list (where you want to continue the numbering).

2. Do one of the following, depending on the part of the user interface you are using:

n Ribbon Select Home > (down arrow).

n Right-Click If the tag block bars are not shown to the left of the content, click at the
bottom of the editor. Right-click the ol or ul tag bar of the lower list (where you want to
continue the numbering).

3. Select Continue Sequence.

4. Click to save your work.
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Merging Lists
There may be times when you are creating lists and find that you have two or more ordered lists
(<ol> tags) or unordered lists (<ul> tags) next to each other. If necessary, you can quickly merge the
lists together into one list.

EXAMPLE You have two numbered lists, with each list restarting at number 1.

You can make the numbering continuous in those two lists by merging them.
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How to Merge Lists
1. If the tag block bars are not shown to the left of the content, click at the bottom of the

editor.

2. Right-click the ol or ul structure bar to the left of one of the lists.

3. Select either Merge With Previous List or Merge With Next List. The lists are merged.

4. Click to save your work.

NOTE If you create a new list next to another one of the same time (e.g., two bulleted lists,
two numbered lists), a floating icon displays. You can click the down arrow to display
options for merging the lists together or to keep them separate.

NOTE If you have a bulleted list next to a numbered list, you can merge them together after
right-clicking the ul or ol structure bar and selecting Merge With Previous List or Merge
With Next List. However, if you have a bulleted or numbered list next to a definition list, you
cannot merge those together.
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Restarting Numbering in Lists
You can create a numbered list in a topic by using the Numbered List button in the Home
ribbon. But what if you need to restart the list at a specific number? The following steps show you
how to do this.

How to Restart Numbering in a List
1. Click in the numbered list where you want to restart the numbering.

2. Select Home > (down arrow).

3. Do one of the following:

n If you want to change the numbering for the entire list, restarting the first item at a
specific number, click List Start Number. Enter a value in the dialog and click OK.

n If you want to change the numbering for a specific item in a numbered list, click Item
Number. Enter a value in the dialog and click OK.

EXAMPLE You have a numbered list from 1 to 10. If you were to click in the
paragraph with the number 7 and then use this option to start numbering at 23,
your list would change so that the numbering displayed as 1 to 6 and then 23
to 26.

4. Click to save your work.
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Reversing Lists
After you have created a list, you can reorder the items in the list so that they appear in reverse
order (i.e., first item is last, last item is first).

How to Reverse a List
1. Place your cursor somewhere in the list.

2. Do one of the following, depending on the part of the user interface you are using:

n Ribbon Select Home > (down arrow).

n Right-Click If the tag block bars are not shown to the left of the content, click at the
bottom of the editor. Right-click the ol or ul tag bar of the list.

3. Select Reverse List.

4. Click to save your work.
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Sorting Lists
After you have created a bulleted or numbered list, you can reorder the items in the list in ascending
or descending order. Also, you have the option of sorting the list immediately, or you can have Flare
Desktop sort it automatically later when you build output. For example, sorting at build time might
be a useful option if you always want a particular list sorted, but multiple authors are working on the
list over a period of time, and you want to ensure that the last author making edits does not forget
to sort the list. Translation is another reason to sort lists at build time. Because languages use
different characters, this ensures that the list in each output is sorted appropriately.

How to Sort a List Immediately
1. Place your cursor somewhere in the list.

2. Do one of the following, depending on the part of the user interface you are using:

n Ribbon Select Home > (down arrow).

n Right-Click If the tag block bars are not shown to the left of the content, click at the
bottom of the editor. Right-click the ol or ul tag bar of the list.

3. Select Sort List. Then choose Ascending or Descending.

4. Click to save your work.

How to Sort a List at Build Time
1. Place your cursor somewhere in the list.

2. Do one of the following, depending on the part of the user interface you are using:

n Ribbon Select Home > (down arrow).

n Right-Click If the tag block bars are not shown to the left of the content, click at the
bottom of the editor. Right-click the ol or ul tag bar of the list.

3. Select Sort List > Sort at Build. Then choose Ascending or Descending.

4. Click to save your work.
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Unbinding Lists
If you have created a list and no longer want the content to be displayed in a list, you can unbind it.
This removes the list tags from the content so that it displays as regular paragraphs.

How to Unbind a List
1. Place your cursor somewhere in the list.

2. Do one of the following, depending on the part of the user interface you are using:

n Ribbon Select Home > (down arrow).

n Right-Click If the tag block bars are not shown to the left of the content, click at the
bottom of the editor. Right-click the ol or ul tag bar of the list.

3. Select Unbind List.

4. Click to save your work.
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APPENDIX

PDFs
The following PDFs are available for download from the Help system.

Tutorials
Autonumbers Tutorial

Back-to-Top Button Tutorial

Context-Sensitive Help Tutorial

Custom Toolbar Tutorial

eLearning Tutorial—Basic

eLearning Tutorial—Advanced

Getting Started Tutorial

Image Tooltips Tutorial

Lists Tutorial

Meta Tags Tutorial

Micro Content Tutorial—Basic

Micro Content Tutorial—Advanced

Responsive Output Tutorial

Single-Sourcing Tutorial

Snippet Conditions Tutorial

Styles Tutorials

Tables Tutorial

Word Import Tutorial
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Cheat Sheets
Context-Sensitive Help Cheat Sheet

Folders and Files Cheat Sheet

Learning & Development Cheat Sheet

Lists Cheat Sheet

Micro Content Cheat Sheet

Print-Based Output Cheat Sheet

Search Cheat Sheet

Shortcuts Cheat Sheet

Structure Bars Cheat Sheet

Styles Cheat Sheet
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User Guides
Accessibility Guide

Analysis and Reports Guide

Architecture Guide

Autonumbers Guide

Branding Guide

Condition Tags Guide

Context-Sensitive Help Guide

Eclipse Help Guide

eLearning Guide

Getting Started Guide

Global Project Linking Guide

HTML5 Guide

Images Guide

Import Guide

Indexing Guide

Key Features Guide

Lists Guide

MadCap Flare Online
Integration Guide

Meta Tags Guide

Micro Content Guide

Navigation Links Guide

Plug-In API Guide

Print-Based Output Guide

Project Creation Guide

QR Codes Guide

Reviews & Contributions With
Contributor Guide

Scripting Guide

Search Guide

SharePoint Guide

Skins Guide

Snippets Guide

Source Control Guide: Git

Source Control Guide:
Perforce Helix Core

Source Control Guide:
Subversion

Source Control Guide: Team
Foundation Server

Styles Guide

Tables Guide

Tables of Contents Guide

Targets Guide

Template Pages Guide

Templates Guide

Topics Guide

Touring the Workspace Guide

Transition From FrameMaker
Guide

Translation and Localization
Guide

Variables Guide

Videos Guide

What's New Guide
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